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Getting Started Guide
This booklet guides you step by step from setup through printing your first 
document using Windows 98, Windows Me, or Windows 2000.

See page 13 for information about contacting Compaq and locating your 
printer warranty.

Setup
For setup, you will need:

> A computer with a CD-ROM drive and USB port

> A USB cable (purchased separately)

> Letter or A4 size paper

Step 1: Check the printer parts

Printer software CD

Color print cartridge
(P/N 10N0026)

Power supply

Black print cartridge*
(P/N 10N0016)

Getting Started 
Guide booklet

Power supply 
cord

Compaq printer

* May be included on some models.
1
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Step 2: Connect the power supply

If the Power light doesn’t come on:

1 Check the power supply connections.

2 Press the Power button.

1 2

3
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Step 3: Install the print cartridges

If your printer came with: You can print with:

Color print cartridge only
(P/N 10N0026)

> Only the color print cartridge in the left carrier
> Only a black print cartridge* in the right carrier
> Both a color and a black print cartridge*

Color print cartridge
(P/N 10N0026)

and a
Black print cartridge
(P/N 10N0016)

> Only the color print cartridge in the left carrier
> Only the black print cartridge in the right carrier
> Both the color and the black print cartridge

* You must purchase a black print cartridge (P/N 10N0016) separately.

1

Warning: Do not touch the gold 
contact areas on the back and bottom 
of the print cartridges.

2

Note: The cartridge 
carrier moves to the 
loading position when 
you open the front cover.

3

3
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4 4

5 5

6 6

One Cartridge: Two Cartridges:

Note: Place 
color cartridge 
in left carrier.

If your printer came with:

7
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Step 4: Connect the USB cable

Step 5: Load up to 100 sheets of plain paper

The location and 
orientation of the 
USB port on your 
computer may be 
different from the 
one shown.

1

2

3

45

Make sure you 
fully extend the 
paper support.

To avoid paper 
misfeeds, slide 
the paper guide 
to the left side 
of the paper.

Letter size paper should 
align with the top of the 
paper support. A4 size 
paper should extend 
slightly above the top.
5
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Step 6: Install the printer software
Now that you have set up your printer, you are ready to install the printer software. 

If your computer is not already on, please turn it on now.

Wait for the Compaq printer software installation screen 
shown in  to appear. If it doesn’t, see page 11.

Click Cancel on any 
screens similar to 
the one shown.

1

Cancel

2

3

4

Next

Click Next and follow 
the instructions until 
the installation is 
complete.
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Congratulations!
You have finished setting up your printer.
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Printing
Now that you have set up your printer and installed the printer software, 
you are ready to print your first document.

Basic printing
Basic printing is as easy as:

1 Load the paper.

2 Open the file you want to print.

3 Customize the printer settings. (For help, see 
the section below, “Using the printer software.”)

4 Print your document.

Using the printer software
Use the Printer Properties (or Printing Preferences) to customize settings so 
your document prints the way you want it. There are several ways to access 
your Printer Properties:

> From the Start menu, click 
Programs  Compaq IJ650  Compaq IJ650 Properties.

> From the Start menu, click Settings  Printers. From the Printers folder, 
right-click on the Compaq IJ650 icon and select Properties.

> From your software application, click File  Print  Properties.

For example, to print the first page of the Getting Started Guide:

1 Load plain paper. For help, see page 5.

2 From the Start menu on your desktop, click 
Programs  Compaq IJ650  Compaq IJ650 Getting Started Guide.

3 From the Guide, click File  Print  Properties

a From the Quality/Color tab, drag the Print Quality slider to the left to 
print quickly, but in lower quality.

Note: Selecting a higher Quality/Speed setting results in better print 
quality, but your documents may take longer to print.
9
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b To learn more:

> Explore the other tabs in the Printer Properties.

> Explore the menus.

> Click Help to view the printer software Help. From the File menu, 
click Exit  when you are finished viewing the Help.

c Click OK to apply the settings and close the Printer Properties.

4 In the Print Range area of the Print dialog box, select Current Page.

5 Click OK to print the current page of the Getting Started Guide.

Printing photos
To print the best looking photos:

1 Use photo paper. We recommend Compaq Inkjet Photo-Glossy Media.

2 In Printer Properties:

> Select the Glossy paper type, if you are using glossy paper.

> Select the Color Photo icon.

> Choose a print quality of 600x600 dpi or higher.

3 Close Printer Properties and print.

Printing envelopes
To print on envelopes:

1 Load up to 10 envelopes vertically, with the 
print side facing you.

2 Adjust the paper guide so it is against the side 
of the envelopes.

3 The stamp location is in the upper-left corner.

4 Select the envelope type from the Paper tab 
of Printer Properties.

5 Close Printer Properties and print.

Printing multiple pages per sheet of paper
You can print two, four, or nine “pages” of your document on a single sheet of 
paper. Explore the Layout tab of the Printer Properties for these and many other 
layout options.
10
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Printing banners
To print a banner, you should have banner paper and software that supports 
banner printing.

> Place the banner paper behind the printer.

> Bring the unattached edge of the first page 
over the printer and into the sheet feeder.

> Place the paper guide against the side of 
the paper.

> Select Banner or Banner A4 on the Paper tab 
of the Printer Properties.

> Print your banner.

Printing transparencies
If you have transparency film:

> Load the transparency so the rough side is facing you (smooth side down).

> Place the paper guide against the edge of the transparency.

> Select Transparency on the Paper tab of Printer Properties.

> Print your transparency.

Getting more from your printer
Your printer is capable of printing many types of projects. Create handouts, book-
lets, posters, and more. Explore the Compaq IJ650 Printer Properties for additional 
features.

Compaq Inkjet Media is specifically engineered to give the best results when used 
with your Compaq inkjet printer. Compaq Inkjet Media may be purchased at your 
local retailer or on the internet.

With printing software, you can create greeting cards, iron-on transfers, and many 
other printing projects. Check the Compaq website periodically for printer activi-
ties and ideas.

From the Start menu, simply click Compaq IJ650  Compaq Online.
11
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Help
This section will help you when you have problems setting up your printer, or you 
need general printing help. For additional help, press the Help button on the 
Printer Properties dialog.

The installation screen did not appear
1 Make sure you click Cancel on any screens similar to  in step 6 on page 6.

2 Make sure the Compaq printer software CD is in your CD-ROM drive.

3 From the desktop, double-click My Computer.

4 Double-click the CD-ROM drive icon.

5 If necessary, double-click setup.exe.

6 Continue with  in step 6 on page 6.

The printer light is blinking
Make sure you have properly loaded the paper into the printer. If there is an error 
message on your screen, follow the instructions on it.

The printer isn’t working
Try the following:

> Check the printer cable. Is it securely plugged into the printer and 
your computer?

> Check the printer status:

a From the Start menu, click Settings  Printers.

b From the Printers folder, double-click the icon for your printer.

c From the Printer menu, make sure:

> Default Printer is selected.

> Pause Printing is not selected.

> If you have connected your printer to a device such as a scanner or fax 
machine, disconnect the printer from that device and connect the printer 
directly to your computer.
13
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> Check the printer port:

a From the File menu of a software application, click Print or Printer Setup.

b In the Where area, make sure your printer port is set to USB.

> Make sure you have not installed multiple copies of the printer software:

a From the Start menu, click Settings  Printers.

b In the Printers folder, make sure there is only one icon for your printer.

c If you have two printer icons for the same printer, try printing a test 
page from each icon. Right-click the icon, select Properties, and then 
click the Print Test Page … button. If the test page prints from one icon 
and not the other, delete the icon for the printer that does not print.

Uninstalling the software
If there is still a problem, uninstall and then reinstall the printer software:

1 From the Start menu, click:
Programs  Compaq IJ650  Uninstall Compaq IJ650.

2 Follow the instructions on your screen.

3 To reinstall the printer software, See “Install the printer software” on 
page 6.

Printer prints blank pages
Make sure you have removed the transparent tape covering the bottom of the 
print cartridges. For help, see page 3.

Paper misfeeds or multiple sheets feed
> Make sure you are using a paper recommended for inkjet printers.

> Do not force the paper down into the printer when you load it. Align the 
top of the paper with the top of the paper support. Note that A4 size paper 
will extend slightly above the support.

> Do not load too much paper in the sheet feeder. The printer will hold 
up to 100 sheets of plain printer paper.

> Adjust the left paper guide so it rests against the left edge of the paper, 
but not so tight as to bow the paper in the feeder.

> Make sure the printer is on a flat, level surface.
14
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Paper Jams
Try removing the paper from the sheet feeder. If the paper is lodged too far into the 
printer and can’t be removed:

1 Press the Power button to turn the printer Off.

2 Pull firmly on the paper to remove it. Raise the front cover and pull the 
paper from the front if necessary.

3 Close the front cover.

4 Press the Power button to turn the printer On.

5 Print your document again.

Pages have poor print quality
> Check the ink level graphic on the Cartidges tab of your Printer Properties. 

An ink cartridge may be out of ink or low on ink.

> Check the print quality setting on your Printer Properties. Try a higher 
quality setting.

> Use a different brand of paper. Each brand of paper accepts ink differently 
and prints with slight color variations. It is recommended that you use 
Compaq Inkjet Media for the best results.

> Align and/or clean the print cartridges from the Printer Properties 
Maintenance tab.

> Don’t use refilled print cartridges. For best results, use Compaq 
recommended supplies.

Contacting Compaq
Visit our Web site at www.compaq.com to:

> Access publications for your printer.

> Download software updates.

> Search for solutions to common problems.

> Learn new ways to use your printer.

> Look for special offers and purchase inkjet supplies and media.

To quickly navigate to the Compaq website, click 
Start Program Files Compaq IJ650  Compaq Online.
15
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Compaq 
Warranty 
Information
How do I obtain 
warranty service?

You may access product 
technical support on 
Compaq’s website at 
www.compaq.com or you 
may call Compaq’s 
Technical Support Center. 
Compaq’s highly trained 
technicians will first try to 
resolve the problem 
through our online 
services or by telephone. If 
your problems cannot be 
resolved using these 
methods, Compaq will 
ship an exchange printer 
to you. Upon receipt of the 
exchange printer, remove 
the ink cartridges and 
cable from the printer you 
are returning. You will 
need to use these with 
your exchange printer. 
Cable and ink cartridges 
are not shipped with the 
exchange printer. 

How do I obtain online 
support?

Compaq offers free 
technical support via its 
Internet web site at 
www.compaq.com. Select 
Support. You may also visit 
the Compaq Support 
Forum at 
forum.compaq.com to 
quickly receive answers to 
your Compaq Inkjet Printer 
questions.

What is not covered by 
this limited warranty?
> Product purchased from 

anyone other than 
Compaq or a Compaq 
authorized reseller

> Product purchased 
outside the United 
States or Canada

> Software products 
except for obligations 
specified in the 
software program 
license agreement

> Routine cleaning, or 
normal cosmetic and 
mechanical wear

> Damage from misuse, 
abuse, or neglect

> Damage from use 
outside the product’s 
usage parameters 

> Damage from use of 
parts not manufactured 
or sold by Compaq

> Damage from 
modification or 
incorporation into other 
products

> Damage from repair or 
replacement of 
warranted parts by 
other than a Compaq 
authorized service 
provider

> Damage to or loss of any 
programs or data

> Damage resulting from 
an act of God

Limited Warranty 
Statement for the 
United States and 
Canada

This One Year Limited 
Warranty applies in the 
United States and Canada 
to Hardware Products 
manufactured or 
distributed by Compaq 
Computer Corporation 
(Compaq) under the 
Compaq brand name.

A Compaq Hardware 
Product is defined as 
Compaq Inkjet Printer. 
Contact your Compaq 
authorized reseller or 
Compaq if you have any 
questions about this 
Limited Warranty. 
Compaq’s obligations with 
respect to Software 
distributed by Compaq 
under the Compaq brand 
name are set forth in the 
applicable end-user license 
agreement. Compaq has 
no other obligation to 
repair or replace software 
under this limited 
warranty. Non-Compaq 
Hardware and Software 
Products are provided on 
an as is basis. However, 
non-Compaq 
manufacturers, suppliers, 
or publishers may provide 
their own warranties.

Terms of the Warranty

Compaq warrants that the 
Hardware Product you 
have purchased from 
Compaq or from a Compaq 
Authorized Reseller is free 
from defects in materials 
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or workmanship under 
normal use during the 
warranty period. The 
warranty period 
commences on the date of 
purchase. Please retain a 
copy of your sales receipt. 
Your sales receipt is your 
proof of the date of 
purchase. This warranty 
extends only to you, the 
original Purchaser. It is 
non- transferable. It 
excludes expendable 
parts. 

During the warranty 
period, Compaq will, at no 
additional charge, repair or 
replace defective parts 
with new parts or, at the 
option of Compaq, 
serviceable used parts that 
are equivalent or superior 
to new parts in 
performance. 

All exchanged parts and 
Products replaced under 
this warranty will become 
the property of Compaq. If, 
after repeated efforts, 
Compaq is unable to 
restore the Product to 
good working order, you 
are entitled to a refund of 
the purchase price. 

This Limited Warranty is 
valid only within the 
United States or Canada, 
and within the country in 
which the Hardware 
Product was purchased.

This Limited Warranty 
extends only to Products 
purchased from Compaq 
or from a Compaq 
authorized reseller. 

This Limited Warranty also 
does not extend to any 
Product that has been 
damaged or rendered 
defective (a) as a result of 
accident, misuse, or abuse; 
(b) as a result of an act of 
God; (c) by operation 
outside the usage 
parameters stated in the 
Product’s User’s Guide; (d) 
by the use of parts not 
manufactured or sold by 
Compaq; (e) by 
modification of the 
Product; or (f) as a result of 
service by anyone other 
than Compaq, a Compaq 
authorized reseller, or a 
Compaq authorized 
service provider. Compaq 
is not responsible for 
damage to or loss of any 
programs or data. Contact 
your local Compaq 
authorized service 
provider for geographic 
restrictions, proof-of-
purchase requirements, 
response time 
commitments and other 
specific on-site service 
requirements.

EXCEPT AS EXPRESSLY SET 
FORTH IN THIS 
WARRANTY, COMPAQ 
MAKES NO OTHER 
WARRANTIES, EXPRESSED 
OR IMPLIED, INCLUDING 
ANY IMPLIED WARRANTIES 
OF MERCHANTABILITY 

AND FITNESS FOR A 
PARTICULAR PURPOSE. 
COMPAQ EXPRESSLY 
DISCLAIMS ALL 
WARRANTIES NOT STATED 
IN THIS LIMITED 
WARRANTY. ANY IMPLIED 
WARRANTIES THAT MAY 
BE IMPOSED BY LAW ARE 
LIMITED TO THE TERMS OF 
THIS EXPRESS LIMITED 
WARRANTY.

Limitation of Remedy 

Compaq is not liable for 
any damages caused by 
the Product or the failure 
of the Product to perform, 
including any lost profits, 
lost savings, incidental 
damages, or consequential 
damages. Compaq is not 
liable for any claim made 
by a third party or made by 
you for a third party.

This limitation applies 
whether damages are 
sought, or a claim made, 
under this warranty or as a 
tort claim (including 
negligence and strict 
product liability), a 
contract claim, or any 
other claim. This limitation 
cannot be waived or 
amended by any person. 
This limitation of liability 
will be effective even if 
Compaq or an authorized 
representative of Compaq 
has been advised by you of 
the possibility of any such 
damages. This limitation 
of liability, however, will 
not apply to claims for 
personal injury.
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U.S.A. State Laws

Some states do not allow 
limitation on how long an 
implied warranty lasts. In 
such states, the limitations 
or exclusions of this 
Limited Warranty may not 
apply to you. Some states 
do not allow the exclusion 
or limitation in incidental 
or consequential damages 
for consumer products. In 
such states, the exclusion 
or limitation of this 
Limited Warranty may not 
apply to you. This Limited 
Warranty gives you 
specific legal rights. You 
may also have other rights 
that may vary from state to 
state. You are advised to 
consult applicable state 
laws for a full 
determination of your 
rights. 
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Notices
This section contains 
information about:

> Notices

> Safety information

Electronic emis-
sion notices 
Federal Communica-
tions Commission (FCC) 
compliance information 
statement
This equipment has been 
tested and found to com-
ply with the limits for a 
Class B digital device, pur-
suant to Part 15 of the FCC 
Rules. Operation is subject 
to the following two condi-
tions: (1) this device may 
not cause harmful interfer-
ence, and (2) this device 
must accept any interfer-
ence received, including 
interference that may 
cause undesired operation.

The FCC Class B limits are 
designed to provide rea-
sonable protection against 
harmful interference in a 
residential installation. 
This equipment generates, 
uses and can radiate radio 
frequency energy and, if 
not installed and used in 
accordance with the 
instructions, may cause 
harmful interference to 
radio communications. 
However, there is no guar-
antee that interference 
will not occur in a particu-
lar installation. If this 
equipment does cause 

harmful interference to 
radio or television recep-
tion, which can be deter-
mined by turning the 
equipment off and on, the 
user is encouraged to try to 
correct the interference by 
one or more of the follow-
ing measures:

> Reorient or relocate the 
receiving antenna.

> Increase the separation 
between the equipment 
and receiver.

> Connect the equipment 
into an outlet on a cir-
cuit different from that 
to which the receiver is 
connected.

> Consult your point of 
purchase or service rep-
resentative for addi-
tional suggestions.

The manufacturer is not 
responsible for any radio or 
television interference 
caused by using other than 
recommended cables or by 
unauthorized changes or 
modifications to this 
equipment. Unauthorized 
changes or modifications 
could void the user’s 
authority to operate this 
equipment.

To assure compliance with 
FCC regulations on electro-
magnetic interference for 
a Class B computing 
device, use a properly 
shielded and grounded 
cable. Use of a substitute 
cable not properly shielded 
and grounded may result 
in a violation of FCC 
regulations.

Any questions regarding 
this compliance informa-
tion statement should be 
directed to: 

Compaq Computer 
Corporation
P. O. Box 692000
Mail Stop 510101 
Houston, TX 77269-2000

Or, call (281) 514-3333

Service and 
Support
Please refer to your Limited 
Warranty Statement for 
information on how to 
obtain service and support 
for your product.

Industry Canada 
compliance statement

This Class B digital appara-
tus meets all requirements 
of the Canadian Interfer-
ence-Causing Equipment 
Regulations.

Avis de conformité 
aux normes d’Industrie 
Canada

Cet appareil numérique de 
la classe B respecte toutes 
les exigences du Règle-
ment sur le matériel 
brouilleur du Canada.
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European Community 
(EC) directives 
conformity

This product is in confor-
mity with the protection 
requirements of EC Coun-
cil directives 89/336/EEC 
and 73/23/EEC on the 
approximation and har-
monization of the laws of 
the Member States relat-
ing to electromagnetic 
compatibility and safety 
of electrical equipment 
designed for use within 
certain voltage limits. 

A declaration of confor-
mity with the require-
ments of the Directive has 
been signed by the 
assigned parties within 
Compaq Computer Corpo-
ration. 

This product satisfies the 
Class B limits of EN 55022 
and safety requirements of 
EN 60950.

Japanese VCCI Notice 

The United Kingdom 
Telecommunications 
Act 1984 

This apparatus is approved 
under the approval num-
ber NS/G/1234/J/100003 
for the indirect connec-
tions to the public tele-
communications systems 
in the United Kingdom.

Energy Star 

The EPA ENERGY STAR 
Computers program is a 
partnership effort with 
computer manufacturers 
to promote the introduc-
tion of energy-efficient 
products and to reduce air 
pollution caused by power 
generation.

Companies participating 
in this program introduce 
personal computers, print-
ers, monitors, or fax 
machines that power 
down when they are not 
being used. This feature 
will cut the energy used by 
up to 50 percent. Compaq 
is proud to be a participant 
in this program.

As an Energy Star Partner, 
Compaq Computer Corpo-
ration has determined that 
this product meets the 
Energy Star guidelines for 
energy efficiency. 

Power supply 
information
If your power supply fails, 
replace it only with the 
Compaq replacement part.

Safety informa-
tion
> If your product is 

NOT marked with this 
symbol , it MUST be 
connected to an electri-
cal outlet that is prop-
erly grounded.

> The power cord must be 
connected to an electri-
cal outlet that is near 
the product and easily 
accessible.

> Refer service or repairs, 
other than those 
described in the oper-
ating instructions, to 
a professional service 
person.

> This product is 
designed, tested, and 
approved to meet strict 
global safety standards 
with the use of specific 
authorized compo-
nents. The safety fea-
tures of some parts 
may not always be 
obvious. The printer 
manufacturer is not 
responsible for the use 
of other replacement 
parts.
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